
 
 
 
 
 
 

HIGHLIGHTS OF NEW FEATURES 
 
1. New Capture Desktop - Experiment Mode    4 
2. New Capture Desk Top - Recipe Mode     5 
3. Export of Raw Data        6 
4. ESCA Control Panel – Replacement for A Quick   8 
5. Motor Control Panel – GPIB Interface     9  
6. Motor Control Panel – Ethernet Interface    10 
7. Position Table        11 
 

TOPICAL DESCRIPTION OF SOFTWARE 
 

In the following sections, topics of operation are discussed in alphabetical order 
1. Calibration and Setup   

a. Introduction to applet       13 
b. Outline of steps        14 
c. Hardware configuration      14 
d. Software configuration      15 
e. Establishing starting calibration values    17 
f. Run DAC to calibrate BE span     19 
g. Run Detector Width Calibration     20 
h. Run V1 curves        21 
i. Signature correction       22 

2. Database Functions       25 
a. Creating a new database      26 
b.   Get recipes from another database     27  

3. Depth Profiles         29 
a. Open the depth profile table generator    29 

4. ESCA Control Panel       31 
a. Unscanned mode       31 
b. Scanned Mode        32 
c. Quick survey        33 
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5. Experiment Names as part of the database structure. 35 
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6. Graphics controls  

a. Chart editor        36 
b. User Preferences       38 
c. Print Utility        39 
d. Spectrum color        41 
e. Clipboard        41 

7. Motion Control 
a. Angle Resolve and tilt stage setup     42 
b. Enable/Disable Buttons      47 
c. Home controls        47 
d. Mode control of the Joystick buttons (6K4)   48 
e. Panic Button        50 
f. Position Table Setup       51 
g. Rotation         54 
h. System Configuration (GPIB, 6K4, disable axes)   55 
i. Units, coordinates       56 
j. Velocity Setup (GPIB with 2100 Indexers)    57 

8. MRS Tables        58 
a. Construction by selecting and editing Functions   59 
b. Templates        62 
c. Run Controls        63 

 
 
 

 
Software conventions 

1. When text boxes are White they will accept data entry. 

2. When text boxes are Blue they are read only. 

3. Buttons or labels that are Red indicate something is turned off. 

4. Buttons that are Green indicate something is turned on. 

5. Buttons that are Yellow indicate something is turned on but temporarily not in 

a useable state. 
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New Capture Desktop - Experiment Mode 
 
 
 
 

  
A Quick is no longer available.  There is no requirement to create a recipe.  When in 
Experiment Mode, simply edit the MRS table to create a parameter set for the next data 
acquisition.  The MRS table will be stored with the data. 
 
The Experiment Tree shows the past experiments.  Selecting an experiment will recall the 
stored MRS table.  You have four options: 
 

1. Run MRS table with a new Project/Experiment name. 
2. Modify MRS table and run with new Project/Experiment name. 
3. Overwrite recalled Experiment. 
4. Save MRS table as a Recipe.  To save MRS as a recipe use File menu, Save 

As – Recipe. 
 

The Clear button provides a quick way to start a new MRS table.  Don’t worry about the 
existing MRS table.  If it has been run it is saved.  All MRS tables saved with 
experiments have the Recipe name “None”. 

 

Experiment Mode Clear MRS table MRS table Experiment Tree 
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New Capture Desk Top - Recipe Mode 
 

 

     
 

1. Save Recipe.  Requires Recipe Mode.   Saves current 
state of MRS table to active recipe.  Save Icon causes 
same action. 
 
2. Save As – Recipe creates a new Category/Recipe. 
May be used from Experiment Mode. 
 
3. In Recipe Mode changes to MRS are NOT saved 
unless the Save Recipe or Save Icon is used.  Recipes 
should not be changed after they are established.  This 
can cause unexpected results in linked Position Tab

 

 
 
To create a new recipe just Clear the current MRS table and then compose a new table.  
Then to turn the MRS table into a Recipe: 
 
1. Go to File menu and select Save AS - Recipe 
2. File out the Category name, Recipe name and description. 
3. You can browse to an existing Category and then edit the Recipe.  This provides a  

fast way to add Recipes in a sequence. 
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Export of Raw Data 
 
 

 
 

1. Select an Experiment.  If only some regions are to be exported mark them visible. 
2. Select Export in the File menu. 
 

    
 
 3. Choose All regions or Only Visible regions.  Select type of export. 
 
 

Export 

Marked Visible 
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Export of Raw Data – Cont. 
 
The VAMAS export is an ASCII file readable by any text editor.  The arrangement of 
information follows the international standard for Surface Science Data.  All region of the 
MRS can be included in one VAMAS file.  The VAMAS file can hold a complete depth 
profile.  This is a very flexible and well-defined export file. 
 
To use the Excel export, Excel must be available on the computer running the ESCA 
application.  It does not need to be running.  The export will open an Excel notebook, fill 
header cells with instrument parameters and provide a column of numbers representing 
the spectrum data.  A crude graph is also created for quick review.  There will be one 
page per spectrum.  All spectra for a MRS table or just the regions marked visible can be 
included.  A depth profile can be exported. 
 
Fakedata.txt is an internal text file used for demonstration purposes.  Any spectra can be 
converted to a fakedata.txt file and then used by the Demo program to simulate the 
collection of data.  This can be convenient for training and remote investigation of the 
program operation. 
 

 
 
The Export File Dialog is used with the VAMAS export.  This is a standard Windows 
dialog.  File storage for the Excel is handled out of the Excel program. 
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ESCA Control Panel – Replacement for A Quick 
 
 
 

  
 
 
 

 
 
 The ESCA control panel is used for direct access to the spectrometer. 
You may change a setup condition and hit start even if a scan is in progress.  The scan 
will automatically abort and restart.  The Time/Step can be changed.  If scanned is 
checked “Capture T” provides an estimate of the total capture time.  The top row of 
controls will change the state of the ESCA when the control is clicked.  The eight 
controls in the frame change state when the Start button or Enter Key is hit.

ESCA Control Panel 

ESCA Control Panel 
view screen

View Menu item, ESCA Control Pnl 
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Motor Control Panel – GPIB Interface 
 
 
 
 
 

 
 
 

1. Configure Motors:   
a. Set type of motion control interface 
b. Turn on/off individual axes. 

2. Velocity Setup: 
a. Set velocity of individual axes. 

3. Home Controls 
a. Set XYZ:  Set current XYZ position 0,0,0 
b. Set R:  Set current R position 0 
c. GOTO XYZ:  Return to XYZ = 0,0,0 
d. GOTO R:  Return to R = 0 or 360 

4. Rotation 
a. Cont. Starts continuous rotation. 
b. Stop Stops continuous rotation. 

5. Panic  Stops all motion and disables Motors. 
6. Motors: Green means Enabled.  Yellow means computer control.  Red 

means Disabled. 
7. Units: 

a. XYZ : Set scale system to MM, Inches or number of steps. 
b. Rotation:  Set scale system to Deg, number of steps or tilt. 
c. GOTO or Get * IF number is present in any white box then motors 

will move to position.  If all boxes empty then computer will get current 
position.  This is useful after Joystick movement of stage.  * denotes that 
the Enter Key will produce this function if form is active. 

 

View Menu item, Motion Control Pnl Motion Control Pnl 
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Motor Control Panel – Ethernet Interface 
 
 

 
 
 
The Ethernet interface and 6K4 controller allow for use of a USB Joystick.  The Joystick 
button has three states: 
 
 Green – Enabled 
 Yellow – Motion under computer control 

Red – Disabled.  This secures the motion system from accidental input while 
running a position table. 
 

The button labeled “Joystick Buttons” controls the state of the remote buttons located of 
the joystick.  Two buttons can be set to update the home positions or to cause forward or 
back stepping through the position table.  The state is toggled between these two 
functions by this button.  The message box in red with yellow letters describes the current 
state. 
 
It will be noticed that one additional difference between the GPIB/2100 Indexer system 
and the Ethernet/6K4 system is the speed of operation.  The Ethernet communication 
provides real time position information during the motion of the stage.  The blue read 
only boxes post the position in real time. 
 
 
 
Page 51 for Position Table Setup 
 
 
 
 
 
 
 



 11

Position Table 
 

 

 
 

 
Steps to set up Position Table: 
 

1. Tool Bar > View > Motion Control Pnl 
2. MRS Table function  > PT M > Table Name (Default in this case) > Design 

Button. 
3. Table options: 

a. Create a new table, Clear the displayed table, Delete the displayed table or 
Save and run table. 

b. Create a table of positions: 
i. Learn positions using joystick.  

ii. Move to positions using control panel, then transfer to table. 
iii. Numerical entry directly to table. 

c. Table Row controls 
i. Add row 

ii. Delete row 
iii. Move row up 
iv. Move row down 

 

PT M design button opens table. 
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4. Review of positions. 
a. Select “numbered” buttons at end of Row.  Stage will move to position. 
b. Select Step forward/Step Back buttons on Table Form. 
c. Select Step forward/Step Back buttons on USB joystick (6K4 controller). 

 
5. Assign recipes 

a. Select Recipe mode.  Click drop down box for each row.  Assign Recipe 
from list. 

 
It is very important to step through all positions before running a table.  We have noticed 
that the positions will not be the same on the first pass after learning.  However, as the 
positions are reviewed buy stepping through them in order, it is easy to refine the stored 
coordinates by using the joystick learn button.  The row cursor automatically follows.  
This usually stabilizes the learned positions. 
 
As the positions are reviewed, be sure limit conditions are not displayed.  During the 
running of a position table a limit condition will keep the stage form moving to the 
correct position.  You will be notified if this occurs. 
 
To run the position table: 
 

1. “Save and Exit” the position table 
2. Enter the Project, Experiment and Experiment description information. 
3. Select the Run (from top) button  

 
During the collection of data the MRS table will display the individual MRS tables for 
each position.  The Experiment Name window will display: 
 
  Your Experiment Name:POS X  where X is the position number. 
 
For more details on Position tables See “Position Table Setup” pg 51 
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Calibration and Setup – Outline of steps 
 
It is very helpful if the calibration parameter values, from the previous 
software, are available.  IF you are upgrading from ESCAVB without a 
change of operating system these steps are not required.  If a new operating 
system was installed then proceed with calibration. 
  

1. Configure the registry entries for the ESCA system hardware. 
2. Configure calibration parameter values that were used in previous software.  If 

these are not available then develop a rough set of starting values. 
3. Run DAC to calibrate the span of the BE scale. 
4. Run Detector Width to calibrate the detector and set the absolute BE. 
5. If the ESCA Instrument has a V1 (lens focus voltage) supply in the 

Spectrometer Power Supply that is digitally controlled then run V1 calibration 
curves. 

6. Return to the main program and set up Signature correction. 
 
Calibration and Setup – Hardware configuration 
 
Use the main tool bar and select the Settings menu.  Select Capture Settings. 
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Calibration and Setup – Hardware configuration - Detector 
  
 
Select the Detector Tab in the Dialog.  If a valid signature file is available then check the 
Signature Correction ON box.  If this is a new installation then see Signature Correction 
section below. 
 
If the “Signature file could not be loaded” message was displayed during the startup of 
the program check the Signature File Path.  The sig.txt file, that holds a valid signature, 
must be available.  The installation will make a dummy sig.txt file that makes no 
signature correction.  It is loaded in the ESCA 2000 folder.  To use this default file make 
sure the path points to the ESCA 2000 folder.  If you set up a custom folder then  enter 
the custom path statement in the Signature file Path window.  
 
The Dither box should be checked if a 2502 fast detector and 2503 buffer memory are 
used.  If a 2401 Position computer is used do not check the Dither box. 
 
Horizontal Linerization is not available in this release. 
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Calibration and Setup – Hardware configuration – X-Rays 
 
Standard settings for a Monochromator system.   
 
 A. Source Type:  Al 
 B.  Filter:   Monochromator 
 C.  Reference Energy: 1486.6 is provided as the accepted value 
 D: Please select the type of X-Ray gun controller 
 

Note:  “Other” is used for X-Ray guns that are not controlled from this 
software.  The VG 8730 can be controlled using the 8702 L/S. 

 
 

 
 

 
Non-Monochromator Systems 
 
 A. Select source Type from list 

B. Select None or Foil.   
 
None will establish a list of satellite peaks with full intensities as specified in the 
literature.  Foil will allow adjustment of the satellite intensities.  This is an empirical 
process.  We assume the satellites are attenuated by the window foil.  The Filter 
Transmission Fraction is the Transmission for the satellite peak compared to the Primary 
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peak.  The Transmission Fraction can be specified for the satellite nearest the Primary 
peak and the satellite farthest from the Primary peak.  A linear variation in transmission is 
computed for the intermediate peaks.  
 
The Filter Transmission Fractions are determined by collecting a spectrum and then using 
the Satellite subtract function in the Tools menu found at the top of the spectrum display 
window.  Adjust the Filter Transmission Fraction for the Near Peak until the subtraction 
produces a smooth baseline in the region of the near satellite.  Then adjust the Filter 
Transmission Fraction for the far peak.  You may need to iterate the setting a few times.  
Your final Transmission values will be saved with all spectra at the time of capture.  The 
satellite subtraction can be performed in the Capture program or the Data Analysis 
program. 
 
Refer to Satellite Subtraction in the Data Analysis section under Manipulating Spectra. 
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Calibration and Setup – Hardware configuration – Spectrometer 
 

 
 

1. Select the type of spectrometer power supply from the drop down list. 
2. Select the type of lens from the drop down list. 

 
If the Spectrometer Power Supply entry is changed then you must exit the Capture 
Application and re-start it so the instrument interface and be re-initialized.  You will be 
reminded of this requirement when the Capture Setting Dialog is closed. 
 
 
Updating the Registry 
 
If you Cancel the dialog or use the “X” button, none of the changes made during your 
session with the Capture Setting Dialog will be saved.  You must use the Update button 
to save your changes.  The dialog will close after the Updates are complete, so it is 
convenient to make all desired changes before Updating.  
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Calibration and Setup – Calibration Parameters 
 
To enter calibration parameters into the registry open the Set up ESCA applet. 
 

 
 
 

 
 

Set Up ESCA Applet. 
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Calibration and Setup – Calibration Parameters 
 
The calibration parameters are entered into the Configuration Table 
located on the Configuration Tab. 
 

 
 

After entering changes to the values you must select the Commit button to wite the 
changes to the registry. 
 
Type 5000 for the MSResSettleTime.  This will shorten the wait time when the resolution 
is changed from 12 seconds to 5 seconds.   
 
If you have calibration values from the HP workstation (9800 series) then one adjustment 
to the calibration values is required.  For each Resolution correct the pass energy.  Use 
the Detector With for the same Resolution as the Pass Energy. 
 
 New Pass energy = Old Pass energy + (Detector Width)/2 
 
If you are upgrading from the DOS Vectra software or  have installed a new operating 
system then use the pass energy that was previously used. 

Configuration tab 
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Calibration and Set up – Calibration Parameters cont. 
Make the following entries to the Configuration table if data is available. 
 

 

 

DAC for 8724 

DAC for 8701 

Motor parameters, 
all 6, not used. 

DeltaEvSpot 
depends on crystal 
adjustment.  Do after 
all other adjustments 

V1 offsets  and Slopes 
for 8701B or 8724 
only.  Note values for 
V1 curve setup. 

Enter Sensitivity Exps 
only if special values 
have been established. 

Enter Pass Energies as 
discussed above.

Use Existing Detector 
Widths if available. 
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Calibration and Set up – Establishing starting calibration values 
 
If the above calibration values are not available then follow these steps: 
 

1. Set DetWidthRes4 to 19 eV and the PassEVRes4 to 166 eV.  Make these entries 
in the configuration table and use the Commit button to register these values.  
Leave all other values as shipped. 

2. Set up a gold sample and be sure all supplies are on.  Set the X Probe 
Spectrometer Setup control panel as shown below and Start Accumulation. 

 
If you are using a 2401 position computer then the dithered box 
should be unchecked.  For a 2503 Memory Interface check the 
dithered box.  This applies at all times. 

 

 
 
This will generate a spectrum of the Au 4f.  With the cursor set at the center of the 7/2 
peak, read the BE at the upper right corner of the spectrum display.  

Start  Accum. 

CBE  85 
WW  50 
Nbr Pt 100 
Scans  1 
Res  4 
Scanned Checked 
X-Rays on – 600 spot 

BE readout 
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Calibration and Set up – Establishing starting calibration values cont. 
 

3. Calculate the following:   
New PassEVRes4 = 166 + (measured peak position – 84).   
Enter the new pass energy into the configuration table and select Commit. 

4. Set up following unscanned spectrum 
a. Remove the check mark from the box titled “Scanned”.   
b. Center BE  =  85.8. 
c. Window Width = It will use the Detector Width.  No input needed. 
d. Number of data points  = It will use 128.  No input needed. 
e. Number of Scans/Reads = 200 
f. Start Accumulation 
After spectrum is accumulated, use cursor to measure separation between the Au 
4f 5/2 and Au 4f 7/2 peaks. 

5. Calculate the following: 
New DetWidthRes4 = 19 * (3.68 / measured peak separation).   
Enter new Detector Width into configuration table and select Commit. 

6. Make following entries: 
a. DetWidthRes2 = (DetWidthRes4) / 3 
b. DetWidthRes3 = (DetWidthRes2) * 2 
c. PassEVRes2 = (PassEVRes4) / 3 
d. PassEVRes3 = (PassEVRes2) * 2 

These starting values will now be used in the automatic program to refine the 
calibration. 
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Calibration and Set up - Run DAC to calibrate BE span. 
 

 
 
The DAC calibration is very simple.  Align the copper sample under the microscope.  
Clean the sample with an Ion Etch.   Then select start.  The spectra will be displayed as 
they are collected.  The display window will provide information as the calibration 
progresses. 
 
The DAC calibration may fail to find the Cu 3s1/2 peak in the preset window.  Small 
errors in the DAC constant will cause large errors in the Cu 3s1/2 peak location.  You 
will need to provide an improved initial estimate of the DAC value.  Run a 100 Ev wide 
scan centered at 120 Ev and a 50 Ev scan centered at 930 Ev.  Find the centers of the Cu 
3s ½  and Cu 2p 3/2 peaks using the cursor.  Compute: 
 
 ((Cu 2p3/2 – Cu 3s1/2) energy separation / 810) * current DAC 
 
Enter this value of the DAC into the configuration table.  Follow steps 1 through 3 above 
to re-establish the Au 4f7/2 line position to 84 Ev.  Re-run the DAC calibration. 
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Calibration and Set up – DAC calibration – cont. 
The DAC calibration can leave the absolute binding energy far out of adjustment.  It is 
only attempting to set the separation between the copper peaks to the correct value.  
Return to the acquisition tab and collect a scanned spectrum at the Au 4f peaks.  Use the 
following setup:   
 
 
 
 
 
 

CBE  85   Res  2 
WW  30  Scans  2 
Nbr Pt 300  Scanned box checked 
X-Rays on – 600 spot 
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Calibration and Set up - Detector Width Calibration 
 
Use the cursor to find the center BE for the Au 4f 7/2 peak.  Find the value of 
PassEVRes2 in the configuration table.  Calculate: 
 
New PassEVRes2 = current PassEVRes2 + (measured peak position – 84).   
 
 Enter the new value of the Pass Energy into the Configuration Table.  Make the same 
calculation for Res 3 and Res 4 but use the Res2 value  (measured peak position  - 84).  
Enter these two values into the configuration table.  Select Commit to record all three 
updated values to the registry. 
 
Select the Detector Width Tab.  Set the run conditions for Res2, Res3 and Re4 as shown 
below.  Select start.  Watch the calibration proceed.  If the calibration fails to find two 
peaks it is usually because the peaks are not well enough centered in the window.  Make 
small changes to the pass energy as described in the paragraph above to center the peaks 
and try again.  This calibration sets the absolute BE for all pass energies. 
 
Note:  Increasing the pass energy moves the peaks to lower BE. 
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Calibration and Set up - V1 curves 
 
This calibration is only needed if the V1 supply is digitally controlled.  The 
V1 curves settings will have no effect on a model 8701 Spectrometer supply 
unless the supply has a digital V1 upgrade.  The optimum voltage setting 
information may be useful for manual adjustment of the supply. 
 

 
 
The V1 curve generator.   
 
The object of running V1 curves is to obtain a set of parameters that optimize the lens 
throughput for all binding energies.  The voltage (V1), that is used to focus the lens, is 
continuously increased over a range of voltages.  As the V1 voltage is changed the 
number of electron that reach the detector is changed.  The goal is to set a start and end 
for the V1 voltage ramp that produces a maximum detector signal away from either end. 
 
 
 

V1 Start 

V1 End 
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Calibration and Set up - V1 curves – cont. 
 
Each Resolution requires two V1 curves.  All curves are created using gold as the sample.  
The spot size setting does not affect the final Slope and Intercept values.  It is best to run 
with larger spots to improve the signal to noise. 
 
The Check boxes, under the include column, control which curves will be run.  The 
button labeled “Run Test” will start the data collection.  After all pairs, that have been 
checked, are run use the calculate button to calculate the Slope and Offset parameters.  
These parameters are used in the software to compute the V1 voltage as a function of V0 
(retardation) voltage that will keep the lens focus optimized for all binding energies.  
Review the computed values.  The slopes and intercepts should increase smoothly and the 
resolution number is increased. 
 
Finally select the update registry button to make the new values take effect.  
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Calibration and Set up – Signature correction 
 
Return to the main Capture program 
 
Select the Capture Settings dialog. 
 

 
 
 
If the ESCA uses a Model 2401 Position computer then the Dither box should not be 
checked.  Check the Dither box if a Model 2503 Memory Interface is used. 
 
Remove the checks from the Signature Correction box and horizontal linerization box. 
 
Enter the Signature File Path as shown above.  This will stop the “Signature file not 
found.” message that is shown when the program is started. 
 
Select update and close the dialog box. 
 
If you have a history of signatures in the C:\Program files\ESCAVB folder, the files can 
be moved to the C:\Program files\ESCA 2000 folder.  These files will have the following 
endings:  sig.txt.1, sig.txt.2, sig.txt.3 etc.  Copy all files in this series. 
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Calibration and Set up – Signature correction cont. 
 
Place an Unscanned Function in the MRS table.  Set the CBE to 510eV.  Input the time as 
10:00 to set it to 10 minutes.  Set the spot to 800 microns and the resolution to Res4.  Use 
Default and Temp for the Project and Experiment.  The collected data does not need to be 
saved.  The computed signature file is saved.  
 
Select Run. 
 

 
 
After the data has been collected just leave it displayed.  Then select the Setting > Create 
a new signature file menu. 
 
 

 
 
 
Select the capture button.  The signature will be computed from the data in the spectrum 
display window of the main program.  The signature will be displayed in the signature 
window. 
 
 

Select Run 

UnScanned function 
Save as Default and Temp 

Capture button converts the Temp 
spectra into a sig.txt file. 

Save the sig.txt file 
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Calibration and Set up – Signature correction – cont. 
 
Select save to save the sig.txt file and back up the last sig.txt as sig.txt.1.   All other sig 
files will be rolled to the next higher number. 
 
Close Signature conversion dialog. 
 
Re-Open the Capture Preferences dialog.  Settings > Capture Preferences in main toolbar.  
Enter a check in the Signature Correction check box. 
 

 
 
 
Set up and calibration is now complete. 

After making entries 
select Update 
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Database Functions 

 
It is highly recommended that each user create a personal Data Base!   
Click on File > New > New Data Base /Protocol.   
 
 
 
 

 
 
 
 
 
 
 
 
 

File New New Data Base/Protocol 
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Database Functions – Creating a new database 
 
Enter the new data base name then select Save. 
 
    
 

 
 
 
 
 
 
 
The categories Depth Profile, Performance Test, Position Table Blank, and Sample 
Project will be automatically loaded with each new Data Base.   
 

 
 
 
 

Enter Database name.   

Save. 
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Database Functions – Get recipes from another database 
 
Recipes can be transferred from one Data Base to another.    
Go to File > Open > and select the Data Base into which Recipes are to be transferred.   
 
Now go to File > Get Categories/Recipes  
 

 
 

Highlight the Data Base that contains the Categories/Recipes to be transferred and click 
on Open.   
 

 
 

File 

Get Categories/Recipes 

Highlight source 
Database. 

Open 



 34

 
Database Functions – Get Recipes from another database – cont. 
 

!!DO NOT TRANSFER OR ALTER THE TEMPLATE DATA 
BASES, ESCA Template.mdb or Programdb.mdb!! 

 
 
In order to transfer a Category and/or the Recipes highlight the Category and hit the 
space bar (note that after highlighting a Category or Recipe, hitting the space bar toggles 
the (-), (+) signs in front of the titles).   
Highlight and hit the space bar once for each Category and Recipe that is to be 
transferred, then click on the Copy button.  
If a Category is showing a (+) and all Recipes below the category show (-) then all 
Recipes in the Category will be copied.  This saves the effort of checking all Recipes. 
 
If a Recipe shows(+) but the Parent Category shows (-) the Recipe may 
not be copied.   If the target database (the one you are coping to) has a 
matching Category then the marked Recipes will be copied. 
 

 

 

Highlight a Category. 
Hit space bar.

Highlight a Recipe (s). 
Hit space bar.

Click on Copy button.  



 35

 
 
 
Depth Profiles – Open the depth profile table generator. 
 

 
 
 

1. Select the Depth Profile function from the function list. 
2. We suggest that the first Template be a default Template.  Use this as a 

temporary table.  It is rare you will reuse a Depth Profile.  Continue to step 4 
if you are going to write over the default template. 

3. If a reusable template is desired then select New.  Edit the Template Name. 
Go onto next step to define the spectrum regions. 

4. Use the Add and Delete buttons to create a table of Region Definitions 
a. Region name is typically the element symbol and transition label.  When 

this convention is used, the data reduction will automatically identify the 
transition and look up the Scofield cross-section. 

b. CBE – Center binding energy 
c. Scanned – checked   WW (window width) must be entered with a non 0 

value.   Scans is number of scans.  If a time is entered as hh:mm:ss, then a 
number of scans will be calculated, but not shown, that equals or exceeds 
the time.   A default eV/step will be offered.   
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Depth Profiles – Cont. 
 
 

d. Scanned –not checked.  WW defaults to detector width, Scans/Time is 
collection time and can be entered as seconds or hh:mm:ss and finally 
eV/step is not required.   

e. You need to enter a Resolution number in all cases. 
f. Hh:mm:ss can be entered as h:mm:ss,  mm:ss or m:ss. 

 
 
5. Set up the Spot Size, Etch Time in seconds or hh:mm:ss, Flood gun state and 

Number of Etch cycles. 
6. The Rotation can be “On” or “Off”.  If rotation is “On” then the sample holder 

will rotate an integer number of rotations during each etch cycle. 
7. Select Paste to Save the Table and Close the Depth Profile Dialog. 
8. Use the ESCA Control Panel to set up and test the sample alignment, and ion 

gun operation. 
9. When ready select any of the Run Buttons. 
10. The Spectrum Viewer will display the Depth Profile during the etch cycle. 
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ESCA Control Panel 

 
Previous versions of the software used A Quick as a simplified control panel.   This 
update replaces A Quick with the ESCA Control Panel.   
 
The first row of the panel presents check boxes allowing for the activation of the Flood 
Gun (charge neutralization), Ion Gun, X-ray Gun and, if applicable, Aperture.   
Changes in these parameters take effect when the boxes are clicked. 
  
The second row and third row are grouped together in a frame.  The fields represented in 
the frame directly control the spectrometer.  The Panel is shown with the scan variable 
not checked.  This is the UNSCANNED mode.  The active variables are (CBE), Spot 
size, spectrometer Resolution, and Capture T (time in seconds).  Changes in these 
parameters take effect when the start button is clicked. 
 
ESCA Control Panel – Unscanned mode 

 

 

ESCA Control 
Panel 

spectrum viewer 

on/off toggles for  
Flood Gun, Ion 

Gun,  
X-ray Gun 

 
pull-down  
menu for  
Aperture 

windows for  
CBE,  
and  

Capture T 
 

pull-down  
menus for  
Spot size,  

and 
Resolution  
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ESCA Control Panel - Scanned Mode 
 
Placing a check in the Scans box provides access to Scans number, Window width, 
eV/step, and Time/step.    
 

 

         
  

 
 

The scanned mode is especially useful for establishing the center binding energies of 
those elements of interest for High Resolution Spectroscopy and also for establishing 
optimum flood gun parameters.    

 

Note that, while in the scanned mode, the Scan Time field is shaded blue.    
This indicates that the Scan Time field is a Read-Only field as it is a variable dependent 
on the other scan parameters.    

Scans box 
activated 

windows for  
Scans,  

Window Width 
and eV/Step 

  
pull-down  
menu for  

Time / Step in 
Milliseconds  
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ESCA Control Panel  - Quick survey.   
 
Place a check in the Scans box, type 500 or 550 into the CBE box and 1000 or 1100 
respectively in the Window box.   
Set Time/step to 50 and click on START.    
Note:  The overhead time per step is 25 milliseconds.  This is not included in the Scan 
time calculation.  
 

 
 

See Big Display at 
bottom of Panel. 

Scans or Time 
Remaining 

Current Count Rate 

Very large display of 
Count Rate. 

This display can be expanded and moved.  
Additional status parameters are then 
displayed.  Available during normal capture. 
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Calibrating the Microscope for Correct Sample Registration 
 
Place a phosphor sample on a flat stage and transfer it to the UHV chamber.    
Use the joystick to manipulate it to the vicinity of the registration point.    
Turn on the Flood Gun, and X-rays.    
Set the CBE for O(1s) at~532 eV.   
Choose the largest Spot size, Resolution 4, and a large number for Capture T 
(3000seconds?).   
While monitoring the counts adjust the Z-axis of the stage for maximum counts.    
Also, insure that the “dot pattern” on the CRT is centered (side-to-side).    
 
NOW, UNTIL THE MICROSCOPE HAS BEEN CALIBRATED, DO NOT USE 
THE JOY STICK OR DO ANY OTHER MANIPULATIONS TO THE STAGE.   
 
Turn off the flood gun (the flood gun emission may make the area irradiated by the  
X-rays difficult to see).   
 
Use the 50X magnification and the eyepiece cross hairs, adjust the Z-axis of the 
microscope so that the irradiated area of the phosphor is in focus.    
Now use the microscope’s X and Y-axes controls to move the eyepiece crosshairs to the 
center of the in-focus irradiated area on the phosphor.   
 
If a small Spot size is to be used change the Spot size settings to the appropriate size and 
recheck the crosshair alignment using the microscope X and Y-axes adjustments.   
 
The microscope is now calibrated.   
 
Now use only the joystick controls to bring samples into focus and areas of interest under 
the eyepiece crosshairs.   
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Experiment Names as part of the database structure 
 
The Project and Experiment Names are displayed in a number of places in the program.  
The two names together form a unique identity for a MRS, Depth profile or one position 
in a position table.  Examples of the tree structures that help to find your data are shown 
below. 
 

 
 

 
 

 
 
Data Analysis keeps Reduced data with Raw Data for ease of recovery.  Raw data is 
never presented for manipulation.  Only a copy is presented in the Spectrum Viewer.

Experiment Tree – Capture  

Experiment Name 

Experiment Name – Name 
entry box. 

Data Analysis Program – 
Experiment tree. 

Experiment Name 

Original Raw Data 

Set of Reduced Data 
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Graphics controls – Chart editor 
 

 
 
The chart editor provides control over all aspects of the Graphic presentation of the 
spectra.  In the following sequence of screens we will show some of the typical controls.  
 
The X and Y axis presentation is controlled on the Axis > Scales page.  The “Axis” 
column in the left frame controls the focus of the “Axis” sub pages. 
 

  
 
Removing grid lines for X axis.  The axis control was changed to Bottom to remove the 
vertical grid lines in the next screen. 

Select Ticks page 
Click Grid Borders 
Remove Visible check 
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Graphics controls – Chart Editor –cont. 
 

 
 

 
 

 
 
 

Titles added 

Bottom Axis selected 

Set Panel Color to White 
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Graphic Controls – User Preferences 
 

 
 
 

 
 
The above sequence shows a few of the capabilities of the Graphic Editor.  Many Fonts, 
font sizes and colors are available.  Legends can be created for Graphics with overlays.  
The panel background can have be a blend of two colors.  An depth profiles can be 
displayed in 3D. 
 

User preferences  Icon 

Title or Footer 
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Graphic Control – Print Utility 
 
The General Page of the Graphic Editor provides access to a Print Utility and Graphic 
Export. 
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Graphic Control – Print Utility – Cont 
 
The Print Preview can be obtained from the Printer Icon or from inside the Chart Editor.  
The Chart Editor provides more flexability.  The Printer Icon provides convience. 
 
 

 
 
 

Example of printout form Graphics Editor 
 

Example of Title

Footer can be figure Number

BINDING ENERGY - eV
500 400 300 200 100 0

C
O

U
N

TS

2.5K

2K

1.5K

1K

500
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Graphic Control – Spectrum color 
 
The color wheel icon provides access to the “Change Color and Line Style” dialog. 
 

 
 
Graphic Control – Clipboard 
 

 
 
The spectrum displayed in the Graphics Viewer can be placed on the Windows Clipboard 
by clicking on the Clipboard Icon.  The image is available for pasting into any Windows 
program. 

Clipboard Icon 
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Motion Control –Angle Resolve and tilt stage setup 
 
 
 
 
 

 
 
 
The tilt stage allows for computer controlled variable takeoff angle (TOA) analysis.   
With the Motion Control Panel open select the PT M function and open the Position 
Table dialog.  This will enable the “Angle Setup” button on the Motion Control Panel. 
Click the “Angle Setup” button on the Motion Control panel to display the Tilt Setup 
dialog.    
 

3. Open Angle Setup 1. Load Motion Control Pnl 

2.  Load Position Table 
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Motion Control –Angle Resolve and tilt stage setup – cont. 
 
The relations ships described in the Tilt Setup are pictured below. 
 
 

Takeoff Angle  
 
 
 
 
 
 
 
 
 
 
 
 
 

Tilt Stage 
Shown with bearing support on right. 

 
 

 
 

Lens axis 

Sample surface 

bearing 
support 

slot in machined 
aperture plate

Grid line marking tilt (X) axis 

Sample normal 

TOA – Surface to 
Lens Axis  - as 
shown in example. 
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Motion Control –Angle Resolve and tilt stage setup – cont. 
 
The tilt stage allows for variable TOA analysis and by rotating the stage about its X-axis. 
The TOA can be varied from 0 to 90 degrees.  Mount the sample by placing it between 
the solid bottom platen and the machined aperture plate.   
 
In order for the software to work properly the following conditions must be met; 
The microscope must be calibrated (refer to the section Adjusting the Microscope for 
Correct Sample Registration on page #17).    
 
Place the sample/stage in the preparation chamber so that the bearing support is located 
on either the left or right side of the stage.   
 
Lower the Z-axis to the minimum position before transferring the tilt stage to the 
UHV chamber.   This is a precautionary step to avoid collisions of the tilt stage with 
the hardware that protrude into the analytical chamber (i.e. flood gun, lens, ion 
gun).    
 
Raise and manipulate the stage and superimpose the microscope eyepiece crosshairs on 
the grid line of the stage.    
This correctly aligns the tilt stage with the X-ray beam and the lens and the R controller 
will now tilt the stage.    
 
In this example a TOA of 35o (sample surface horizontal or flat) will be initially defined 
as home (0, 0, 0, 0).   An approximate setting of the horizontal is sufficient for this initial 
setting. 

a Using the unscanned data acquisition mode and a strong elemental line adjust the 
Z-axis for maximum counts and click on the SET XYZ Home(see next page).   

b Now use the Y-axis to move away from the tilt axis (do not move Z).    
 If the counts and signal (dot pattern on the detector) remains constant, then the 

stage is positioned correctly at TAO of 35o (or 55o if using the lens axis to sample 
normal as the definition of TOA).   If not use R (low speed) and adjust the tilt for 
maximum counts and click on SET R.   This accurately sets the horizontal plane 

c Use GOTO home XYZ to return to the tilt axis.  Check and refine the alignment 
of the grid line on the top machined plate so that it overlaps the microscope cross 
hair.   
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Motion Control –Angle Resolve and tilt stage setup – cont. 
 

Aligning Sample for Angle Resolve Analysis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Note angles entered in the R column in the position table on page 42.  Enter the set of 
angles you plan to use in the experiment.  Use the add line, delete line etc to organize the 
table as you choose. 
 
The steps completed to this point are: 
 

1. Select the tile configuration in the Tilt Setup dialog.  Close dialog 
2. Align the Home condition for the tilt stage as outlined above. 
3. With the Motion Control Panel Measurement System set to degrees enter the 

tilt angles for your experiment. 
 
Now Select the Tilt Measurement System (see pg 42) in the Motion Control Panel.  Your 
input numbers will be converted to Raw motor steps.  This conversion will account for 
the tilt stage gear ratio and the Tilt Setup configuration.  The final table is displayed 
below.  
 
 
 
 
 

Use the Y-axis and/or 
R to align an area  
away from center.   

Click SET R. 

Use Z-axis controller 
to align center of 

sample. 
Click SET XYZ...

slot in machined 
aperture plate 

Grid line marking tilt (X) axis 
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Motion Control –Angle Resolve and tilt stage setup – cont. 
 
 

 
 
 
The Recipes are assigned by selecting the Recipe Display Mode and selecting the 
Recipes from the dropdown dialog. 
 
 
 
 
 
 
 
 
 
 
 
 

Select Recipe Mode 

Select tilt measurement 
system. 

Select recipes 
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Motion Control – Enable/Disable Buttons 
 

 
 
Review the last three screens that show the Motion Control Panel.  Notice the Motors and 
Joystick buttons take on the colors Red, Yellow and Green depending on the state of the 
Motion control system.  Clicking either button will toggle the state of the Motors or the 
Joystick between enabled and disabled (Green or Red). 
 

1. Disabling the Motors turn the power to the motors off. 
2. Disabling the Joystick block Joystick control of the motors. 

 
The yellow state is displayed during computer-controlled movement.  Notice that a 
number of control panel buttons are disabled during computer-controlled motion. 
 
NOTE:  If the motion system stops working it is often sufficient to Disable the Motors 
and then re-enable them to restore normal operation.  Your Home position will not be 
lost. 
 
Motion Control – Home controls 
 

 
 
 
The  GOTO R button causes the rotation position to return to 0 deg or 360 deg. 
 

Set current  (x,y,z) 
position to (0,0,0) 

Moves stage to 
(x,y,z) = (0,0,0) 

Set current (r) 
position to (0) 

Moves rotation 
to (r ) = (0) 
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Motion Control –Mode control of the Joystick buttons (6K4). 
 

 
 

 
 
 

Clicking the “Joystick buttons” button toggles the function of the two front buttons on the 
Joystick.  When the Joystick home is enabled, then the left front button set the current 
XYZ position as home.  Likewise, the right front button will set the current rotation 
position as home.  This is very convenient for initially setting a home position while 
observing the sample with the microscope. 
 
Later, when reviewing the learned sample positions, the mode can be switched.  When 
the home function is disabled in the Motion Control Panel then the Joystick Step Next/ 
Step Back Function is enabled in the Position Table.   
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JOYSTICK CONTROL BOX – USB  model 

 

 
 
 
 
 

 
The joystick controls motion along the X (left/right), Y (forward/back) and “Z axes (press 
center button while moving the Joystick forward-back).  Rotation is obtained by twisting 
the outer ring clockwise/counter clockwise.   
 
The Get function “Gets “ the current coordinates and fills or updates in the position cell 
in the position table.  

Joystick 

XYZ        Set Home          R 
Back             Step Position       Next 

Get 
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Motion Control – Panic Button 

 

The PANIC button is used to immediately stop all motion!    
 

 
 
All motion is stopped and power is removed from the motors.  The current home location 
is not lost. 
 
To restore normal operation select the Motor button and then the Joystick button.  After 
both buttons turn green, the Motion system will be ready for operation 
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Motion Control - Position Table Setup 
 
Setting up the Position Table disables Recipes so, when possible, compose Recipes 
beforehand.    

 
Use the Function pull down menu and select PT M.   Then click the design button (“The 
Pencil”) Icon.  This activates the Position Table – Multi Recipe Panel.  If the Motion 
Control Panel is not open it will be opened along with the Position Table. 
 
 

 
 
Set Home 
 
Go to the microscope and set the cross hair on the axis of rotation.   Go to the SET row of 
the MOTION Controls Panel and click on XYZ.    
 
Move toward the edge of the holder, preferably the first sample.  SET this position as 
Home for R.   An initial reference co-ordinate system is now set that can be reproduced if 
there is a glitch.   

PT M Function 

Position Table – 
Multi Recipe Panel

Design Icon 
“The Pencil”
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Motion Control - Position Table Setup cont. 
 
Learning Positions 
 
There are two modes of adding rows to the position table.  They are controlled by the 
radio buttons in the Get Current Positions frame. 
 

1. Select the Update mode.  Each time the Add Line button, on the position table 
form is clicked, a blank row will be added to the table.  When the Get Position 
button is clicked the values for each axis will be updated.    

2. Select the Auto Add mode.  Rows are added and filled in each time the Get 
Position button is selected. 

 
The Update mode is convenient for updating or refining the coordinates for an existing 
table.  The Auto Add mode is best when building a table from scratch. 
 
NOTE:  The Joystick Get Position button works the same as the button on the form.  
With Auto Add selected, you can learn all your positions without going back to the 
computer. 
 
Choose one of the above modes of operation.  Put the cursor on the X axis cell of the first 
row.  Row (1).  The X axis cell is arbitrary but a good practice.  With the stage aligned on 
position, (Pos 1) click the Get Position button on the Joystick or on the Position table 
form.  The Special Function button is the Get Position button for the old Joystick.  If you 
chose the Update mode the coordinate cells of row (1) will be filled.  If you chose the 
Auto Add mode then you will have a new row at the bottom of the table with the values 
for the current position.   
 
In the update mode, you will continue to put the cursor on the X column of the row that 
matches your sample.  You will move to a new position and select the Get Position 
button. 
 
In the Auto Add mode you will continue moving to new positions and selecting the Get 
Position button.  When you are finished, delete any rows left over from previous tables.  
You will then be left with a table properly numbered. 
 
The screen on the next page shows the controls discussed. 
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Motion Control - Position Table Setup cont. 
 

 
 
NOTE:  With the GPIB/2100 Indexer system the Joystick operation is not connected 
to the computer.  Continuous polling of the Indexers to see if there has been Joystick 
activity leads to less reliable operation.  The “Goto or Get” button on the Motion 
Control Panel is used to request current stage position.  This provides the required 
update.  The Motion Control Panel button ONLY updates the Motion Control 
display.  The Get Position Button on the Position Table and the Joystick update 
both the Motion Control Panel and the Position Table. 
 

SET XYZ, 
SET R Goto or 

Get 

Get 
Position 

Positions 
toggle 

Update 
toggle 

Name the new 
position table 
or pull down 
stored table 
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Motion Control - Position Table Setup cont. 
 
After the desired positions have been entered into the Position Table click on the Recipe 
button.  This expands the Position Table – Multi Recipe Panel so that Recipes may be 
assigned for each position.    
 
Save the table and Run the analysis.    
 

 
 
 
 
 
 
If, after acquiring the data set, more data is needed, create the appropriate Recipes and 
insert them into the previous position table.    
Then Save again.   
 
Previously stored position tables may be reused and edited to accommodate different sets 
of samples.    
 
Motion Control - Rotation 
 

 
 

Recipe button 
Recipe 

pull-down 
menu 

Descriptions and/or 
comments may be 

inserted here. 

Save. 

Starts continues rotation 

Stops continues rotation 
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Motion Control – System configuration. 
                                                         

 

 
 

This configuration dialog will be displayed when the software is first installed.  Your 
responses will be stored in the registry. 
 
 

1. No Motors then use “None”  
2. National GPIB card us 2100 
Indexers with HPIB. 
3.  New motion system use 6K4. 

On new installations, check all 
installed axes. 
If a fault message suggests you 
should uninstall a motor, remove 
the check for the reported axis. 
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Motion Control – Units, coordinates. 
 

 
 
XYZ Scale units are: 

1. mm = millimeters 
2. inch = inches 
3. raw = number of motor steps (250,000 / inch) 

 
R Scale units are: 
  

1. deg = degrees 
2. raw = number of motor steps (36,000 / turn – 6K4 or 25,000 / turn GPIB) 
3. tilt = converts TOA (Take Off Angle) to raw.  See Motion Control – Angle 

Resolved. 
 
Enter position coordinates and then click Goto (or keyboard Enter) for manual control.  If 
no position coordinates are entered (i.e. White boxes are empty) then the current motor 
positions will be recovered from 2100 Indexers.  This is not required with 6K4. 

Read only – Current position 

Manual entry  - (X,Y,Z,R) 
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Motion Control – Velocity Setup (GPIB with 2100 Indexers only) 
 
The Velocity Setup only controls the velocities for computer, not joystick control.   
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MRS Tables  

 
A capture screen, with a new database loaded, will show no MRS table.  Select a Recipe 
to load the MRS table constructor functions. 
 

 
 

 
 
In this case the Sample Project > Default Recipe was selected.  The MRS for this Recipe 
is a simple survey.  We can start from this MRS and modify it to create the parameter 
table for the Spectrum capture desired.  First, a review of the possibilities.
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MRS Tables  - Construction by selecting and editing Functions. 
 

 
 
Adding a new function. 

 

 
 
Drop down the Function menu 
 

 
 
Select a Function 
 

 
 

Click on add 
function.   

Drop function menu.   

Select a function.   
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MRS Tables – Construction buy editing Functions cont. 

 
 
 

FUNCTION TABLE CONTROLS 
 

 
 

The controls for the manipulation of the functions in the table are described above.  The 
underlined A and X can be executed from the keyboard by using Alt-A or Alt-X.   

    
 

 
 
A Function (in this case a Survey) creates a list of default data acquisition parameters. 
The default values are often ok but it is quick to customize the values. For example, the 
number of Scans is often increased or the BE conditions are changed.  
 
NOTE:  Time, stated as hh:mm:ss, can be entered instead of number of scans.  The 
program will compute a number of scans that most closely matches the requested 
time.  A calculation of zero scans will be run as one scan.  
 
The default parameter eV/step is set optimum for the selected resolution (Res#).    
This applies to high resolution (ResHi) and high Sensitivity (HiSen) scans.   
 

Scans/Time 

Clear MRS table.  Leaves top function. 
 
Set next row up the active function 
 
Set next row down the active function 
 
Add new function 
 
Delete current function 
 
Move current function up one row 

 
Move current function down one row
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MRS Tables - Construction by editing Functions cont. 
  
 
NOTE:  TAB or the mouse must be used to step out of the Function column.    
In the Function column the arrow keys move up and down the Function list and not 
from Function to parameter columns or Function to Function.    
The arrow keys move up and down or side to side in the parameter columns.    
SHIFT TAB will tab right to left.  It is fast to fill in a table and then “arrow” down the 
scan column and set the number of scans at one time. 

 
High Resolution scans and High Sensitivity scans may be added to the table as required 
by the analysis.   For these two cases the binding energy is changed form the default 
values.  This is quickly accomplished by “Arrowing” down the BE column. 
 
 

 
 
 
The above Multi Region Scan (MRS) has a survey and four high resolutions Region.  
Each region has been named for ease of identification.  The region name will default to 
Region 1, Region2 etc if the names are not entered. 
 

Region name 
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MRS Tables – Templates 
 

 
 
The table above displays three templates for the high sensitivity function.  After selecting 
a function you can drop-down the list of named templates that hold a set of default 
values.  For frequently used parameter sets you may want to define your own set of 
default templates. 
 

 
 
To create a new template: 

1. Select the New Icon. 
2. Enter a new Template Name. 
3. Enter the parameter values for your template in the appropriate boxes. 
4. The check box will lock the value so it can’t be changed from the MRS table. 
5. Select the Paste Icon to save the template and post the name to the Function 

list. 

Template drop-down  
menu.

Design button 

Check to lock value 



 69

MRS Tables  - Run Controls 
 
 

  
 
Befor running the MRS table a Project Name and Experiment Name must be provided.  
These two names taken together create a unique idenity for the MRS in the database.  The 
Experiment Description is for additional information that make clear the Experiment.  
The discription is not used for finding the data.  It is supplied after the data is recovered. 
 
Most of the time there will be a Project Name and Experiment Name in the input boxes.  
These names will be left from the previous state of the Capture Program.  It is most likely 
you will not change the Project Name.  This assumes that you will do many Experiments 
for one Project.  The typical operation will be to write over or modify the Experiment 
Name.  You may add letters or numbers to show a sequence in the experiments. 
 
After taking care of the Project Name, Experiment Name and Description Select a Run 
Control. 
 
 
 
 

Three Run Controls are found above the Function Table.   The lines in the Function 
Table can be run to capture a sequence of regions.    
The Run button runs the complete Function Table from line 1 to the bottom of the table.    
The second button labeled One only runs the current active (highlighted) line.    
The bottom button labeled End runs from the current active line to the bottom of the 
Function Table.Once a capture is started additional buttons appear to control 
termination.  
  

Run button 
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  Pause, Stop , Abort and Append buttons appear to the right of the three run buttons.  
        

 
 
  Pause – MRS tables.  Pause will temporarily stop the capture so a change can be made 

to the number of scans or capture time.   In order to continue, click again on Pause.  
 
 Pause – Depth Profiles.   Pause will temporarily stop the capture of a scan.  During the 

pause the etch time or number of cycles may be changed.  In order to continue, click 
again on Pause.  If Pause is used during the etch cycle the current etch cycle will finish 
and then the Pause will be executed. 

 
  Pause – Position Tables.  Pause will effect the MRS table of the current position. 
 
  Pause – Ion Etch,  The stand alone Etch function will pause during the etch.  The etch 

time can be changed.  
 
  Stop – MRS Table.  “Stop” is used to stop a scan at the nearest endpoint.   If the 

capture is unscanned then the capture will stop immediately.   
 
  Stop – Depth Profiles.  “Stop” acts as an abort during a the Depth Profile.   
 
  Stop – Position Tables.   “Stop” will stop the Position Table MRS at the end of the 

running spectrum.  The Position table will be aborted. 
 
  Abort stops all operations immediately.  The data taken up to the time of the Abort is 

saved. 
 
  Append :  Normal operation is Overwrite.  If a new experiment  name is not entered, 

then the re-run of the current experiment overwrites the existing data.  If you want to 
collect additional data under the current experiment name then you may use the Append 
mode.  This can be used to add a new region to the experiment or to collect additional 
data for one or more regions.  The Appended data may easily be added to the original 
data by using the Add Spectra function in the Tools menu.  The Append mode reverts 
back to the overwrite mode after the Appended data has been collected. 
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MRS Tables  - Run display 
 
The data being acquired will be visible in the Spectrum Viewer.    
During data acquisition binding energies may be measured by placing the cursor on the 
peaks, their binding energies can be seen below in the Display Bar.    

 

 
 
 
 
 
 
 
 

The Spectrum Viewer is used to display the current active spectrum and it will always 
be displayed in this window during data acquisition.    
Below the Spectrum Viewer/ Document Control area is a display bar that shows the 
status of the capture process.    
During a capture the Idle indicator will switch to Running.    
The information inside of the parenthesis will show the Recipe that is being run.  
Additional parameters of the capture will also be displayed in this window.    
The next window in the Status Bar displays the cursor parameters.    
The third window displays the Scofield Table showing probable peak assignments as a 
function of cursor position.    

 
 

Capture Status Display Bar Scofield Table 
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Next section is Data Analysis 
 
The data analysis provide for Compositional Analysis, Peak Fitting, Depth Profile 
analysis and other data manipulation. 
 
To open the Data Analysis from the Capture program Click on View > Data Reduction.    
 
 
 
 
 

 
 

 
 
 

Data Analysis 
button


